Chapter 704

Superiority by a Margin Tests for the Difference of Two Hazard Rates Assuming an Exponential Model

Introduction

A clinical trial is often employed to test the clinical superiority of a treatment over a control in regards to the survival distributions. The two-sample t-test is not appropriate for two reasons. First, the data are not normally distributed. Second, some survival times are censored. For these reasons, special test statistics such as the logrank test have been developed. This module computes the sample size and power for a clinical superiority test similar to the logrank test, assuming survival times follow exponential distributions. Accrual time and follow-up time are included among the input parameters.

This procedure is based on the unconditional method of Chow, Shao, and Wang (2008) which, in turn, is based on the conditional methods of Lachin and Foulkes (1986). The conditional procedure does not extend to this case (see Chow, Shao, and Wang (2008) page 173).

Technical Details

This section presents the unconditional clinical superiority method of Chow, Shao, and Wang (2008).

Basic Model

Suppose a clinical trial consists of two independent groups labeled “1” and “2” (where group 1 is the control group and group 2 is the treatment group). The total sample size is \( N \) and the sizes of the two groups are \( N_1 \) and \( N_2 \). Usually, you would plan to have \( N_1 = N_2 \).
Clinical Superiority Hypothesis

Assuming that lower hazard rates are better, clinical superiority is established by concluding that the treatment hazard rate is lower than the control hazard rate by at least a small margin $\Delta$. The statistical hypotheses that yields this conclusion when the null hypothesis is rejected is

$$H_0 : (h_2 - h_1) \geq -\Delta \quad \text{versus} \quad H_a : (h_2 - h_1) < -\Delta$$

or

$$H_0 : h_2 \geq h_1 - \Delta \quad \text{versus} \quad H_a : h_2 < h_1 - \Delta.$$ 

If, however, higher hazard rates are better, non-inferiority is established by concluding that the treatment hazard rate is at most, only slightly lower than the control hazard rate. The statistical hypotheses that yields this conclusion when the null hypothesis is rejected is

$$H_0 : (h_2 - h_1) \leq \Delta \quad \text{versus} \quad H_a : (h_2 - h_1) > \Delta$$

or

$$H_0 : h_2 \leq h_1 + \Delta \quad \text{versus} \quad H_a : h_2 > h_1 + \Delta.$$ 

Test Statistic

The power and sample size formulas presented below are for the difference of two exponential hazard rates. Simulation studies have shown that they also approximate the power of the logrank test. It is anticipated that the actual test statistic is the regression coefficient from a Cox regression.

Test Comparing Hazard Rates

The original test statistic is the difference of the hazard rates estimated by maximum likelihood divided by their standard error. The maximum likelihood estimate of an exponential hazard rate for a particular group is

$$\hat{h} = \frac{\text{number of events}}{\text{sum of study time of all subjects}}$$

Chow, Shao, and Wang (2008) indicate that the test statistic

$$Z = \frac{(\hat{h}_2 - \hat{h}_1) - \Delta}{\sqrt{\frac{\sigma^2(\hat{h}_1)}{N_1} + \frac{\sigma^2(\hat{h}_2)}{N_2}}}$$

where

$$\sigma^2(\hat{h}) = \frac{h^2}{1 + \frac{e^{-hR}(1 - e^{hR})}{hR}}$$

This $Z$ statistic is approximately normally distributed.
Power Calculations

Assuming an exponential model with hazard rates $h_1$ and $h_2$ for the two groups, Chow et al. (2008) give the following equation relating $N$ and power of a superiority test, assuming that lower hazards are better.

$$\frac{(h_2-h_1)+\Delta}{\sigma^2(h_1,\omega_1,A) + \frac{\sigma^2(h_2,\omega_2,A)}{N_1} + \frac{\sigma^2(h_2,\omega_2,A)}{N_2}} - z_{1-\alpha} = z_{1-\beta}$$

where

$$\sigma^2(h_i,\omega_i,A) = \frac{h_i^2}{E(d_i|h_i,\omega_i,A)}$$

$$E(d_i|h_i,\omega_i,A) = \left(\frac{h_i}{h_i+\omega_i}\right)\left(1 + \frac{A \exp\left[-(h_i+\omega_i)T\right][1-\exp\left((h_i+\omega_i-A)R\right)]}{(h_i+\omega_i-A)[1-\exp\left(-AR\right)]}\right)$$

$$E(d_i|h_i,\omega_i,0) = \left(\frac{h_i}{h_i+\omega_i}\right)\left(1 + \frac{\exp\left[-(h_i+\omega_i)T\right][1-\exp\left((h_i+\omega_i)R\right)]}{(h_i+\omega_i)R}\right)$$

These parameters are interpreted as follows.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\sigma^2(h_i,\omega_i,A)$</td>
<td>Variance of $\hat{h}$</td>
</tr>
<tr>
<td>$E(d_i</td>
<td>h_i,\omega_i,A)$</td>
</tr>
<tr>
<td>$d_i$</td>
<td>Indicates the a person does $(d_i = 1)$ or does not $(d_i = 0)$ die in group $i$</td>
</tr>
<tr>
<td>$h_i$</td>
<td>Hazard rate of group $i$ (see below)</td>
</tr>
<tr>
<td>$\omega_i$</td>
<td>Loss to follow-up hazard rate of group $i$ (see below)</td>
</tr>
<tr>
<td>$A$</td>
<td>Patient entry parameter (see below)</td>
</tr>
<tr>
<td>$R$</td>
<td>Accrual time</td>
</tr>
<tr>
<td>$T$</td>
<td>Total time</td>
</tr>
<tr>
<td>$T - R$</td>
<td>Follow-up time</td>
</tr>
</tbody>
</table>
Exponential Distribution

The hazard rate from the exponential distribution, \( h \), is usually estimated using maximum likelihood techniques. In the planning stages, you have to obtain an estimate of this parameter. To see how to accomplish this, let's briefly review the exponential distribution. The density function of the exponential is defined as

\[
f(t) = h \exp\{-ht\}, \quad t \geq 0, h > 0.
\]

The cumulative survival distribution function is

\[
S(t) = \exp\{-ht\}, \quad t \geq 0.
\]

Solving this for \( h \) yields

\[
h = -\frac{\log{S(t)}}{t}
\]

Note that \( S(t) \) gives the probability of surviving \( t \) years. To obtain a planning estimate of \( h \), you need only know the proportion surviving during a particular time period. You can then use the above equation to calculate \( h \).

Patient Entry

Patients are enrolled during the accrual period. PASS lets you specify the pattern in which subjects are enrolled. Suppose patient entry times are distributed as \( g(t) \) where \( t_i \) is the entry time of the \( i^{th} \) individual and \( 0 \leq t_i \leq R \).

Let \( g(t) \) follow the truncated exponential distribution with parameter \( A \), which has the density

\[
g(t) = \begin{cases} 
A \exp\{-At\} & \text{if } 0 \leq t \leq R, \quad A \neq 0 \\
\frac{1}{1 - A \exp\{-AR\}} & \text{otherwise}
\end{cases}
\]

where

\( R \) is accrual time.

\( A \) is interpreted as follows:

- \( A > 0 \) results in a convex (faster than expected) entry distribution.
- \( A < 0 \) results in a concave (slower than expected) entry distribution.
- \( A = 0 \) results in the uniform entry distribution in which \( g(t) = 1/R \).

Rather than specify \( A \) directly, PASS has you enter the percentage of the accrual time that will be needed to enroll 50% of the subjects. Using an iterative search, the value of \( A \) corresponding to this percentage is calculated and used in the calculations.
Losses to Follow-Up

The staggered patient entry over the accrual period results in censoring times ranging from \( T - R \) to \( T \) years during the follow-up period. This is often referred to as administrative censoring, since it is caused by the conclusion of the study rather than by some random factor working on an individual. To model the losses to follow-up in each group which come from other causes, we use the exponential distribution again, this time with hazard rates \( \omega_1 \) and \( \omega_2 \). You can obtain appropriate loss-to-follow-up hazard rates using the following formula or by using the Survival Parameter Conversion Tool available from the Tools menu or by pressing the small button to the rate of the loss-to-follow-up hazard rate box.

\[
\omega = - \frac{\log\left(1 - P_{\text{loss}}(R)\right)}{R}
\]

Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are Power or Sample Size. Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level. Select Power when you want to calculate the power.

Test Direction

Higher Hazards Are

In most studies, a lower hazard rate is better since it indicates a longer life-time. However, in some situations, a higher hazard rate is desired. For example, if the length of life of disease organisms is being studied. This option lets you specify which option you have.

Each option results in different null and alternative hypotheses:

- **Higher Hazards Are Worse (Ha: \( h_2 < h_1 - \Delta \))**
  In this case lower is better. The alternative hypothesis is that the treatment hazard rate is lower than the control hazard rate by a clinically significant amount, \( \Delta \).

- **Higher Hazards Are Better (Ha: \( h_2 > h_1 + \Delta \))**
  In this case higher is better. The alternative hypothesis is that the treatment hazard rate is greater than the control hazard rate by a clinically significant amount, \( \Delta \).
Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal survival curves when in fact the curves are different.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you reject the null hypothesis of inferiority when in fact the treatment group is non-inferior.

Values of alpha must be between zero and one. Since this is a one-sided test, it is common for people to use 0.025 rather than 0.05 for alpha.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on N1 or N2 or both.

The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter R = N2/N1, solve for N1 and N2**
  For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2, with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
  \[
  N2 = R \times N1. 
  \]

- **Enter percentage in Group 1, solve for N1 and N2**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed N1 and N2 with this percentage to obtain the desired power.

R (Group Sample Size Ratio)
*This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”*

R is the ratio of N2 to N1. That is,

\[
R = \frac{N2}{N1}. 
\]

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this ratio are considered.

N2 is related to N1 by the formula:

\[
N2 = \lceil R \times N1 \rceil, 
\]

where the value \( \lceil Y \rceil \) is the next integer \( \geq Y \).
For example, setting $R = 2.0$ results in a Group 2 sample size that is double the sample size in Group 1 (e.g., $N_1 = 10$ and $N_2 = 20$, or $N_1 = 50$ and $N_2 = 100$).

$R$ must be greater than 0. If $R < 1$, then $N_2$ will be less than $N_1$; if $R > 1$, then $N_2$ will be greater than $N_1$. You can enter a single or a series of values.

**Percent in Group 1**
*This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for $N_1$ and $N_2.”*

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for $N_1$ and $N_2$. Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

---

**Sample Size (When Not Solving for Sample Size)**

**Group Allocation**
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

- **Equal ($N_1 = N_2$)**
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter $N_1$ and $N_2$ individually**
  This choice permits you to enter different values for $N_1$ and $N_2$.

- **Enter $N_1$ and $R$, where $N_2 = R \times N_1$**
  Choose this option to specify a value (or values) for $N_1$, and obtain $N_2$ as a ratio (multiple) of $N_1$.

- **Enter total sample size and percentage in Group 1**
  Choose this option to specify a value (or values) for the total sample size ($N$), obtain $N_1$ as a percentage of $N$, and then $N_2$ as $N - N_1$.

**Sample Size Per Group**
*This option is displayed only if Group Allocation = “Equal ($N_1 = N_2$).”*

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for $N_1$, and also the value for $N_2$.

The Sample Size Per Group must be $\geq 2$. You can enter a single value or a series of values.

**$N_1$ (Sample Size, Group 1)**
*This option is displayed if Group Allocation = “Enter $N_1$ and $N_2$ individually” or “Enter $N_1$ and $R$, where $N_2 = R \times N_1$.”*

$N_1$ is the number of items or individuals sampled from the Group 1 population.

$N_1$ must be $\geq 2$. You can enter a single value or a series of values.
**N2 (Sample Size, Group 2)**

This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”

N2 is the number of items or individuals sampled from the Group 2 population.

N2 must be ≥ 2. You can enter a single value or a series of values.

**R (Group Sample Size Ratio)**

This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1} \]

Use this value to obtain N2 as a multiple (or proportion) of N1.

N2 is calculated from N1 using the formula:

\[ N2 = \lceil R \times N1 \rceil \]

where the value \( \lceil Y \rceil \) is the next integer ≥ Y.

For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.

R must be greater than 0. If \( R < 1 \), then N2 will be less than N1; if \( R > 1 \), then N2 will be greater than N1. You can enter a single value or a series of values.

**Total Sample Size (N)**

This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines N1 and N2.

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.

You can enter a single value or a series of values.

**Percent in Group 1**

This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

---

**Sample Size – Loss Hazard Rates**

\( \omega_1 \) (Loss Hazard Rate of Control Group)

This is the lost to follow-up rates in group 1, the control group. This rate assumes that lost to follow-up follows an exponential distribution. This value is the reciprocal of the average number lost to follow-up per unit of time (months, years, etc.).

If all you have is the proportion lost to follow-up, use the Survival Parameter Conversion Tool to convert this proportion into a hazard rate.

Any non-negative value is valid. Zero is used to indicate no loss to follow-up.
ω2 (Loss Hazard Rate of Treatment Group)
This is the lost to follow-up rates in group 2, the treatment group. This rate assumes that lost to follow-up follows an exponential distribution. This value is the reciprocal of the average number lost to follow-up per unit of time (months, years, etc.).

If all you have is the proportion lost to follow-up, use the Survival Parameter Conversion Tool to convert this proportion into a hazard rate.

Any non-negative value is valid. Zero is used to indicate no loss to follow-up.

Equal to ω1
Enter ‘ω1’ if you want ω2 = ω1.

Sample Size – Duration

R (Accrual, or Recruitment, Time)
The accrual (or recruitment) time is the length of time during which patients enter the study. It is the value of R.

Percent of R Until 50% are Accrued
This option controls the pattern of patient entry by specifying the percentage of the accrual time needed to enroll 50% of the patients. PASS assumes that patient entry times follow the truncated exponential distribution. This parameter controls the shape and scale of that distribution. The cumulative truncated exponential distribution is given by the equation:

\[ G(T|A) = A \exp(-AT)/[1-\exp(-AR)] \]

When G(T|A) is 50% and R and T are known, this equation may be solved for A.

Range
Values between 1 and 97 may be entered.

Recommended
If you expect uniform patient entry, enter 50. Unless you know that patient enrollment will not be uniform during the accrual period, you should enter 50.

If you expect more patients to enter during the early part of the accrual period, enter an amount less than 50 such as 30. A 30 here means that 50% of the patients will have been enrolled when 30% of the accrual time has elapsed.

If you expect more patients to enter during the latter part of the accrual period, enter an amount greater than 50 such as 70. A 70 here means that 50% of the patients will have been enrolled when 70% of the accrual time has elapsed.

T-R (Follow-Up Time)
The follow-up time is the length of time between the entry of the last individual into the study and the end of the study. Since T is the total length of the study and R is the accrual time, the follow-up time is T-R.
Effect Size

Specify Hazard Parameters Using
Specify which of the parameters below will be used to specify the treatment group hazard rate and the non-inferiority margin by checking the appropriate button.

- **Differences**
  Enter the values of D and Δ. The value of h2 is determined from D.

- **Rates**
  Enter the values of h2 and B (clinical superiority boundary) directly.

**h1 (Hazard Rate of Control Group)**
Specify one or more hazard rates (instantaneous failure rates) for the control group. The exponential survival distribution used in this procedure assumes that the hazard rates are constant throughout the whole experiment and that this hazard rate is equal to one over the mean number of events per unit of time.

An estimate of the hazard rate may be obtained from the median survival time or from the proportion surviving past a certain time point by pressing the Survival Parameter Conversion Tool button.

**Range**

h1 > 0

**Examples**
The following examples assume an exponential survival distribution.

<table>
<thead>
<tr>
<th>Median Survival Time</th>
<th>Hazard Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5</td>
<td>1.386</td>
</tr>
<tr>
<td>1.0</td>
<td>0.693</td>
</tr>
<tr>
<td>2.0</td>
<td>0.347</td>
</tr>
<tr>
<td>3.0</td>
<td>0.231</td>
</tr>
<tr>
<td>4.0</td>
<td>0.173</td>
</tr>
<tr>
<td>5.0</td>
<td>0.139</td>
</tr>
</tbody>
</table>

**h2 (Hazard Rate of Treatment Group)**
Specify one or more hazard rates (instantaneous failure rates) of the treatment group. When lower hazards are better, h2 must be less than h1 - Δ. When higher hazards are better, h2 must be greater than h1 + Δ.

**Range**

h2 > 0

**B (Clinical Superiority Boundary)**
Specify one or more values of B, the superiority boundary. Note that B = h1 - Δ when lower hazards are better and B = h1 + Δ when higher hazards are better.

**Range**

When lower hazards are better, B < h1. When higher hazards are better, B > h1.
D (Hazard Rate Difference = h2-h1)
Specify one or more values of the difference in hazard rates, h2 – h1. This value is used with h1 to specify a value of h2 using the formula h2 = h1 + D.

Range
If lower hazard rates are better, the experiment is trying to establish that h2 is less than h1 by a margin Δ, so you must have D < -Δ.

If you higher hazard rates are better, the experiment is trying to establish that h2 is greater than h1 by a margin Δ, so you must have D > Δ.

Δ (Non-Inferiority Margin)
Specify one or more values of the clinical superiority margin, Δ. This is the smallest distance below (or above) h1 that h2 can be that still results in the conclusion that the treatment is clinically superior to the control.

Range
Δ > 0
Example 1 – Finding the Sample Size

Suppose the hazard rate when using the current treatment of a disease is 2. A company wants to show that their new treatment for the disease clinically better. In fact, they want to show that the hazard rate decreases by at least 25%. How large of a sample is needed if the recruitment period is one-year after which the study continues for an additional two-years? It is assumed that patients will enter the study uniformly over the recruitment period. The researcher estimates the loss-to-follow rate to be 0.165 in both the current and the groups. The company would like to compare sample sizes when the power is 0.80 and 0.90 and when D is between -1.6 and -0.80. The researcher will test at the 0.05 significance level.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Superiority by a Margin Tests for the Difference of Two Hazard Rates Assuming an Exponential Model procedure window by expanding Survival, then Two Survival Curves, then clicking Superiority by a Margin, and then clicking on Superiority by a Margin Tests for the Difference of Two Hazard Rates Assuming an Exponential Model. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Higher Hazards Are</td>
<td>Worse (Ha: h2 &lt; h1 - ∆)</td>
</tr>
<tr>
<td>Power</td>
<td>0.8 0.9</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>ω1 (Loss Hazard Rate of Control Group)</td>
<td>0.165</td>
</tr>
<tr>
<td>ω2 (Loss Hazard Rate of Treatment Group)</td>
<td>ω1</td>
</tr>
<tr>
<td>R (Accrual, or Recruitment, Time)</td>
<td>1</td>
</tr>
<tr>
<td>Percent of R Until 50% are Accrued</td>
<td>50</td>
</tr>
<tr>
<td>T-R (Follow-Up Time)</td>
<td>2</td>
</tr>
<tr>
<td>Specify Hazard Parameters Using</td>
<td>Differences</td>
</tr>
<tr>
<td>h1 (Hazard Rate of Control Group)</td>
<td>2</td>
</tr>
<tr>
<td>D (Hazard Rate Difference = h2-h1)</td>
<td>-1.6 to -0.8 by 0.2</td>
</tr>
<tr>
<td>∆ (Clinical Superiority Margin)</td>
<td>0.5</td>
</tr>
</tbody>
</table>
## Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Sample</th>
<th>Control Sample</th>
<th>Trtmnt Sample</th>
<th>Control Hazard Rate</th>
<th>Hazard Rate Diff</th>
<th>Clinical Superiority Margin</th>
<th>Control Loss Rate</th>
<th>Trtmnt Loss Rate</th>
<th>Accrual Time</th>
<th>Follow Up Time</th>
<th>Alpha</th>
<th>Rpt Row</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.8032</td>
<td>48</td>
<td>24</td>
<td>24</td>
<td>2.000</td>
<td>-1.600</td>
<td>0.500</td>
<td>0.165</td>
<td>0.165</td>
<td>1.0</td>
<td>2.0</td>
<td>0.050</td>
<td>1</td>
</tr>
<tr>
<td>0.8059</td>
<td>76</td>
<td>38</td>
<td>38</td>
<td>2.000</td>
<td>-1.400</td>
<td>0.500</td>
<td>0.165</td>
<td>0.165</td>
<td>1.0</td>
<td>2.0</td>
<td>0.050</td>
<td>2</td>
</tr>
<tr>
<td>0.8017</td>
<td>132</td>
<td>66</td>
<td>66</td>
<td>2.000</td>
<td>-1.200</td>
<td>0.500</td>
<td>0.165</td>
<td>0.165</td>
<td>1.0</td>
<td>2.0</td>
<td>0.050</td>
<td>3</td>
</tr>
<tr>
<td>0.8019</td>
<td>278</td>
<td>139</td>
<td>139</td>
<td>2.000</td>
<td>-1.000</td>
<td>0.500</td>
<td>0.165</td>
<td>0.165</td>
<td>1.0</td>
<td>2.0</td>
<td>0.050</td>
<td>4</td>
</tr>
<tr>
<td>0.8002</td>
<td>832</td>
<td>416</td>
<td>416</td>
<td>2.000</td>
<td>-0.800</td>
<td>0.500</td>
<td>0.165</td>
<td>0.165</td>
<td>1.0</td>
<td>2.0</td>
<td>0.050</td>
<td>5</td>
</tr>
<tr>
<td>0.9005</td>
<td>66</td>
<td>33</td>
<td>33</td>
<td>2.000</td>
<td>-1.600</td>
<td>0.500</td>
<td>0.165</td>
<td>0.165</td>
<td>1.0</td>
<td>2.0</td>
<td>0.050</td>
<td>6</td>
</tr>
<tr>
<td>0.9013</td>
<td>104</td>
<td>52</td>
<td>52</td>
<td>2.000</td>
<td>-1.400</td>
<td>0.500</td>
<td>0.165</td>
<td>0.165</td>
<td>1.0</td>
<td>2.0</td>
<td>0.050</td>
<td>7</td>
</tr>
<tr>
<td>0.9001</td>
<td>182</td>
<td>91</td>
<td>91</td>
<td>2.000</td>
<td>-1.200</td>
<td>0.500</td>
<td>0.165</td>
<td>0.165</td>
<td>1.0</td>
<td>2.0</td>
<td>0.050</td>
<td>8</td>
</tr>
<tr>
<td>0.9007</td>
<td>384</td>
<td>192</td>
<td>192</td>
<td>2.000</td>
<td>-1.000</td>
<td>0.500</td>
<td>0.165</td>
<td>0.165</td>
<td>1.0</td>
<td>2.0</td>
<td>0.050</td>
<td>9</td>
</tr>
<tr>
<td>0.9001</td>
<td>1152</td>
<td>576</td>
<td>576</td>
<td>2.000</td>
<td>-0.800</td>
<td>0.500</td>
<td>0.165</td>
<td>0.165</td>
<td>1.0</td>
<td>2.0</td>
<td>0.050</td>
<td>10</td>
</tr>
</tbody>
</table>

### Second Section of Numeric Report

<table>
<thead>
<tr>
<th>Beta</th>
<th>Total Events</th>
<th>Control Events</th>
<th>Trtmnt Events</th>
<th>Percent Control</th>
<th>Trtmnt Hazard Rate</th>
<th>Hazard Ratio</th>
<th>Clinical Superiority Ratio</th>
<th>Clinical Superiority Boundary</th>
<th>Var’nce of h1 hat σ²(h1)</th>
<th>Var’nce of h2 hat σ²(h2)</th>
<th>Rpt Row</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1968</td>
<td>34.8</td>
<td>22.1</td>
<td>12.8</td>
<td>50.0</td>
<td>0.400</td>
<td>0.200</td>
<td>0.750</td>
<td>1.500</td>
<td>4.353</td>
<td>0.300</td>
<td>1</td>
</tr>
<tr>
<td>0.1941</td>
<td>60.2</td>
<td>34.9</td>
<td>25.3</td>
<td>50.0</td>
<td>0.600</td>
<td>0.300</td>
<td>0.750</td>
<td>1.500</td>
<td>4.353</td>
<td>0.541</td>
<td>2</td>
</tr>
<tr>
<td>0.1983</td>
<td>110.3</td>
<td>60.6</td>
<td>49.6</td>
<td>50.0</td>
<td>0.800</td>
<td>0.400</td>
<td>0.750</td>
<td>1.500</td>
<td>4.353</td>
<td>0.851</td>
<td>3</td>
</tr>
<tr>
<td>0.1981</td>
<td>240.2</td>
<td>127.7</td>
<td>112.5</td>
<td>50.0</td>
<td>1.000</td>
<td>0.500</td>
<td>0.750</td>
<td>1.500</td>
<td>4.353</td>
<td>1.236</td>
<td>4</td>
</tr>
<tr>
<td>0.1998</td>
<td>734.9</td>
<td>382.2</td>
<td>352.7</td>
<td>50.0</td>
<td>1.200</td>
<td>0.600</td>
<td>0.750</td>
<td>1.500</td>
<td>4.353</td>
<td>1.698</td>
<td>5</td>
</tr>
<tr>
<td>0.0995</td>
<td>47.9</td>
<td>30.3</td>
<td>17.6</td>
<td>50.0</td>
<td>0.400</td>
<td>0.200</td>
<td>0.750</td>
<td>1.500</td>
<td>4.353</td>
<td>0.300</td>
<td>6</td>
</tr>
<tr>
<td>0.0997</td>
<td>152.0</td>
<td>83.6</td>
<td>68.4</td>
<td>50.0</td>
<td>0.800</td>
<td>0.400</td>
<td>0.750</td>
<td>1.500</td>
<td>4.353</td>
<td>0.851</td>
<td>8</td>
</tr>
<tr>
<td>0.0953</td>
<td>331.7</td>
<td>176.4</td>
<td>155.3</td>
<td>50.0</td>
<td>1.000</td>
<td>0.500</td>
<td>0.750</td>
<td>1.500</td>
<td>4.353</td>
<td>1.236</td>
<td>9</td>
</tr>
<tr>
<td>0.0999</td>
<td>1017.6</td>
<td>529.2</td>
<td>488.4</td>
<td>50.0</td>
<td>1.200</td>
<td>0.600</td>
<td>0.750</td>
<td>1.500</td>
<td>4.353</td>
<td>1.698</td>
<td>10</td>
</tr>
</tbody>
</table>

### References


### Report Definitions

- Power is the probability of rejecting a false null hypothesis. Power should be close to one.
- N is the total sample size.
- N1 and N2 are the sample sizes of the control and treatment groups.
- h1 and h2 are the hazard rates in the control and treatment groups.
- D is the difference in hazard rates: h2-h1.
- HR is the hazard ratio: h2/h1.
- ∆ is the clinical superiority margin.
- B is the clinical superiority boundary = h1 - ∆.
- r is the clinical superiority ratio = B / h1.
- ω1 and ω2 are the rates at which subjects in groups 1 and 2 are lost to follow up.
- R is the accrual (recruitment) time.
- T-R is the follow-up time. Hence, T is the total time of the study.
- Alpha is the probability of a type two error: failing to reject a false null hypothesis.
- Beta is the probability of a type two error: rejecting a true null hypothesis.
- E1 and E2 are the number of events required in the control and treatment groups.
- %N1 is the percent of the total sample that is in group 1, the control group.
- σ²(h1) and σ²(h2) are the variances of the estimates of h1 and h2.
- Rpt Row is a line number assigned to allow corresponding report lines to be identified.
Summary Statements

A clinical superiority test of the difference between hazard rates with an overall sample size of 48 subjects (of which 24 are in the control group and 24 are in the treatment group) achieves 80% power at a 0.050 significance level to detect clinical superiority when the actual difference in hazard rates is -1.600 (0.400 in the treatment group minus 2.000 in the control group). The clinical superiority margin is 0.500. Patients enter the study during an accrual period of 1.0 time periods. 50% of the enrollment is complete when 50.00% of the accrual time has past. A follow-up period of 2.0 time periods has a 0.165 loss to follow-up rate in the control group and a 0.165 loss to follow-up rate in the treatment group. These results assume that the data are approximately exponentially distributed.

These reports show the values of each of the parameters, one scenario per row. The second report presents information about the number of events that are necessary.

Plots Section

These plots show the relationship between power and sample size.
Example 2 – Validation using Chow et al. (2008)

Chow et al. (2008) page 172 present an example of a two-group, equal sample allocation superiority design to compare the hazard rates of a new treatment with that of the current treatment using a logrank test. The sample size is to be large enough to detect non-inferiority when $h_1 = 2$, $h_2 = 1$, and $\Delta = 0.2$. A 3-year study is contemplated with a 1-year, uniform accrual. There is no loss-to-follow up. Alpha is set to 0.05 and power is 0.80. Chow et al. (2008) carried out their calculations to only two decimal places. Their results were

\[
N_1 = \left( \frac{1.64 + 0.84}{2 - 1 - 0.2} \right)^2 \left( 97 + 3.94 \right) \\
= 47.185 \\
\approx 48
\]

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Superiority by a Margin Tests for the Difference of Two Hazard Rates Assuming an Exponential Model procedure window by expanding Survival, then Two Survival Curves, then clicking Superiority by a Margin, and then clicking on Superiority by a Margin Tests for the Difference of Two Hazard Rates Assuming an Exponential Model. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>$Ha: h_2 &lt; h_1 - \Delta$ [Lower Hazard Better]</td>
</tr>
<tr>
<td>Power</td>
<td>0.8</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal ($N_1 = N_2$)</td>
</tr>
<tr>
<td>$\omega_1$ (Loss Hazard Rate of Control Group)</td>
<td>0</td>
</tr>
<tr>
<td>$\omega_2$ (Loss Hazard Rate of Treatment Group)</td>
<td>$\omega_1$</td>
</tr>
<tr>
<td>R (Accrual, or Recruitment, Time)</td>
<td>1</td>
</tr>
<tr>
<td>Percent of R Until 50% are Accrued</td>
<td>50</td>
</tr>
<tr>
<td>T-R (Follow-Up Time)</td>
<td>2</td>
</tr>
<tr>
<td>$h_1$ (Hazard Rate of Control Group)</td>
<td>2</td>
</tr>
<tr>
<td>Specify Hazard Parameters Using</td>
<td>Differences</td>
</tr>
<tr>
<td>D (Difference, $h_2-h_1$)</td>
<td>-1</td>
</tr>
<tr>
<td>$\Delta$ (Clinical Superiority Margin)</td>
<td>0.2</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Sample Size</th>
<th>Control Sample Size</th>
<th>Treatment Sample Size</th>
<th>Control Hazard Rate</th>
<th>Treatment Hazard Rate</th>
<th>Hazard Rate Diff h2-h1</th>
<th>Control Loss Hazard Rate</th>
<th>Trtmt Loss Hazard Rate</th>
<th>Accrual Time</th>
<th>Follow Up Time</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.8034</td>
<td>100</td>
<td>50</td>
<td>50</td>
<td>2.000</td>
<td>-1.000</td>
<td>0.200</td>
<td>0.000</td>
<td>0.000</td>
<td>1.0</td>
<td>2.0</td>
<td>0.050</td>
</tr>
</tbody>
</table>

Second Section of Numeric Report

<table>
<thead>
<tr>
<th>Beta</th>
<th>Total Events</th>
<th>Control Events</th>
<th>Treatment Events</th>
<th>Percent Control</th>
<th>Trtmt Hazard Rate</th>
<th>Hazard Ratio h2/h1</th>
<th>Clin'l Super'ty Ratio</th>
<th>Clin'l Super'ty Bndry</th>
<th>Var'nce of h1 hat σ²(h1)</th>
<th>Var'nce of h2 hat σ²(h2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1966</td>
<td>95.3</td>
<td>49.6</td>
<td>45.7</td>
<td>50.0</td>
<td>1.000</td>
<td>0.500</td>
<td>0.900</td>
<td>1.800</td>
<td>4.032</td>
<td>1.094</td>
</tr>
</tbody>
</table>

The value of N1 = 50 is close to Chow’s hand calculated 48, with difference due to rounding.